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ABSTRACT

The aim of this project is to measure solar cell parameters
through multiple sensor data acquisition. In this project a solar
panel is used which keeps monitoring the sunlight. Here different
parameters of the solar panel like the light intensity, voltage,
current and the temperature are monitored. The microcontroller
used here is PIC16F8 family.

The light intensity is monitored using an LDR sensor, voltage
by voltage divider principle, current by current sensor and
temperature by temperature sensor. All these data are displayed
on a 16X2 LCD interfaced to PIC microcontroller.

The power supply consists of a step down transformer
230/12V, which steps down the voltage to 12V AC. This is
converted to DC using a bridge rectifier. The ripples are removed
using a capacitive filter and it is then regulated to +5V using a
voltage regulator 7805 which is required for the operation of
microcontroller and other circuits.

10
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HARDWARE COMPONENTS:

1.

2.

9.

TRANSFORMER (230 - 12V AC)
VOLTAGE REGULATOR (LM 7805)
RECTIFIER

FILTER

PIC MICROCONTROLLER (PIC 16F877A)
LCD DISPLAY

SOLAR PANEL

LM35

LDR

10.1N4007

11. LED

12.RESISTOR

13. CAPACITOR
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TRANSFORMER

Transformers convert AC electricity from one voltage to another with a little loss
of power. Step-up transformers increase voltage, step-down transformers reduce
voltage. Most power supplies use a step-down transformer to reduce the dangerously

high voltage to a safer low voltage.

FIG 4.1: ATYPICAL TRANSFORMER

The input coil is called the primary and the output coil is called the secondary.
There is no electrical connection between the two coils; instead they are linked by an
alternating magnetic field created in the soft-iron core of the transformer. The two lines
in the middle of the circuit symbol represent the core. Transformers waste very little
power so the power out is (almost) equal to the power in. Note that as voltage is
stepped down and current is stepped up.

The ratio of the number of turns on each coil, called the turn’s ratio, determines
the ratio of the voltages. A step-down transformer has a large number of turns on its
primary (input) coil which is connected to the high voltage mains supply, and a small
number of turns on its secondary (output) coil to give a low output voltage.

TURNSRATIO = (Vp / Vs) = (Np / Ns)
Where,
Vp = primary (input) voltage.
Vs = secondary (output) voltage
Np = number of turns on primary coil
13
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Ns = number of turns on secondary coil
Ip = primary (input) current

Is = secondary (output) current.

Ideal power equation

The ideal transformer as a circuit element

If the secondary coil is attached to a load that allows current to flow, electrical power is
transmitted from the primary circuit to the secondary circuit. Ideally, the transformer is
perfectly efficient; all the incoming energy is transformed from the primary circuit to the
magnetic field and into the secondary circuit. If this condition is met, the incoming

electric power must equal the outgoing power:

JPinc\crming - IP];;; - Pﬂutgoing — ISL;!

Giving the ideal transformer equation

V. N, I
V, N, 1L

Transformers normally have high efficiency, so this formula is a reasonable

approximation.
14
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If the voltage is increased, then the current is decreased by the same factor. The
impedance in one circuit is transformed by the square of the turns ratio. For example, if
an impedance Zs is attached across the terminals of the secondary coil, it appears to
the primary circuit to have an impedance of (Nw/Ns)>Zs. This relationship is reciprocal,
so that the impedance Z, of the primary circuit appears to the secondary to be
(Ns/ Np)* Zp.

VOLTAGE REGULATOR 7805

Features

* Output Current up to TA.

* Output Voltages of 5, 6, 8,9, 10, 12, 15, 18, 24V.
+ Thermal Overload Protection.

+ Short Circuit Protection.

* Output Transistor Safe Operating Area Protection.

Description
The LM78XX/LM78XXA series of three-terminal positive regulators are available
in the TO-220/D-PAK package and with several fixed output voltages, making them

15
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useful in a Wide range of applications. Each type employs internal current limiting,

thermal shutdown and safe operating area protection,

making

it essentially

indestructible. If adequate heat sinking is provided, they can deliver over 1A output

Current. Although designed primarily as fixed voltage regulators, these devices can be

used with external components to obtain adjustable voltages and currents.

Absolute Maximum Ratings

Parameter Symbal Value Unit
Input Votage (for Vo = 5V to 18V) V] B V
(for Vi = 24V) Vi Ll V
Thermal Resistance Junchon-Cases (T0-220) RalC 5 W
Thermal Resistance Junchon-Air (T0-220) RaJa 4] W
Operating Temperature Range (KATECUAR) ToPR 0~+25 v
Storage Temperature Range Tete £5~+150 C

TABLE 4.2(b): RATINGS OF THE VOLTAGE REGULATOR

Service By KRRC (Central Library)
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RECTIFIER

A rectifier is an electrical device that converts alternating current (AC), which

periodically reverses direction, to direct current (DC), current that flows in only one

direction, a process known as rectification. Rectifiers have many uses including as

components of power supplies and as detectors of radio signals. Rectifiers may be

made of solid state diodes, vacuum tube diodes, mercury arc valves, and other

components. The output from the transformer is fed to the rectifier. It converts A.C. into
pulsating D.C. The rectifier may be a half wave or a full wave rectifier. In this project, a
bridge rectifier is used because of its merits like good stability and full wave
rectification. In positive half cycle only two diodes( 1 set of parallel diodes) will conduct,
in negative half cycle remaining two diodes will conduct and they will conduct only in

forward bias only.

17
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FILTER

Capacitive filter is used in this project. It removes the ripples from the output of
rectifier and smoothens the D.C. Output received from this filter is constant until the
mains voltage and load is maintained constant. However, if either of the two is varied,
D.C. voltage received at this point changes. Therefore a regulator is applied at the
output stage.

The simple capacitor filter is the most basic type of power supply filter. The use
of this filter is very limited. It is sometimes used on extremely high-voltage, low-current
power supplies for cathode-ray and similar electron tubes that require very little load
current from the supply. This filter is also used in circuits where the power-supply ripple
frequency is not critical and can be relatively high. Below figure can show how the

capacitor changes and discharges.

Bridge
Rectifier

Load

I
o

[ N N N\
ovt v v y \

Resultant Output Waveform
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MICRO CONTROLLER PIC16F877A

28/40/44-Pin Enhanced Flash Microcontrollers

aiktcdspace.org
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High-Performance RISC CPU:

* Only 35 single-word instructions.

« All single-cycle instructions except for program branches, which are two cycle.

* Operating speed: DC — 20 MHz clock input DC — 200 ns instruction cycle

Service By KRRC (Central Library)
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* Up to 8K x 14 words of Flash Program Memory, Up to 368 x 8 bytes of Data Memory
(RAM), Up to 256 x 8 bytes of EEPROM Data Memory.

+ Pin out compatible to other 28-pin or 40/44-pin, PICT16CXXX and PICT6FXXX
microcontrollers.

Special Microcontroller Features:

+ 100,000 erase/write cycle Enhanced Flash program memory typical.

+ 1,000,000 erase/write cycle Data EEPROM memory typical.

+ Data EEPROM Retention > 40 years.

« Self-reprogrammable under software control.

* In-Circuit Serial Programming™ (ICSP™) via two pins.

* Single-supply 5V In-Circuit Serial Programming.

*Watchdog Timer (WDT) with its own on-chip RC oscillator for reliable operation.
* Programmable code protection.

+ Power saving Sleep mode.

+ Selectable oscillator options.

* In-Circuit Debug (ICD) via two pins.

Peripheral Features:
« TimerO0: 8-bit timer/counter with 8-bit prescaler.

+ Timer1: 16-bit timer/counter with prescaler, can be incremented during Sleep via
external crystal/clock.

+ Timer2: 8-bit timer/counter with 8-bit period register, prescaler and postscaler.
* Two Capture, Compare, PWM modules

- Capture is 16-bit, max. resolution is 12.5 ns

- Compare is 16-bit, max. resolution is 200 ns

- PWM max resolution is 10-bit

- Synchronous Serial Port (SSP) with SPI™ (Master mode) and 12C™
(Master/Slave).

* Universal Synchronous Asynchronous Receiver Transmitter (USART/SCI) with 9-bit

20
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address detection.
« Parallel Slave Port (PSP) — 8 bits wide with external RD, WR and CS controls (40/44-
pin only).
* Brown-out detection circuitry for Brown-out Reset (BOR).

Analog Features:

e 10-bit, up to 8-channel Analog-to-Digital Converter (A/D)

e Brown-out Reset (BOR)

e Analog Comparator module with:
i) Two analog comparators.
ii) Programmable on-chip voltage reference (VREF) module.
iii) Programmable input multiplexing from device inputs and internal

voltage reference.

iv) Comparator outputs are externally accessible.

CMOS Technology:

* Low-power, high-speed Flash/EEPROM technology.
« Fully static design.

+ Wide operating voltage range (2.0V to 5.5V).

« Commercial and Industrial temperature ranges.

* Low-power consumption.

21
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Program Data . MSSP .
Device | Memo EEPRO| ;0 10-bit CCP USAR| Timel comparat
Y SRA Ty AD |(PW e PR
M | (Bytes| |[(ch) |Mm) 8/16-
i (Byte ) Mast bit
Byte|# Single  |s) SP|er
s |Word | 1<C
Instructio
ns
PIC16F8 | 7.2 409 192| 128 [ 22| 5 2 |Ye| Yes| Yes | 2/ 2
73A K 6 S 1
PIC16F8 | 7.2 409 192| 128 | 33| 8 2 |Ye| Yes| Yes | 2/ 2
74A K 6 S 1
PIC16F8 [14.3 819 368| 256 | 22| 5 2 |Ye| Yes| Yes | 2/ 2
76A K 2 S 1
PIC16F8 [14.3 819 368| 256 | 33| 8 2 |Ye| Yes| Yes | 2/ 2
77A K 2 S 1

PIC16F873A/876A devices are available only in 28-pin packages, while
PIC16F874A/877A devices are avail- able in 40-pin and 44-pin packages. All devices
in the PIC16F87XA family share
differences:

* The PIC16F873A and PIC16F874A have one-half of the total on-chip memory of the

PIC16F876A and PICT16F877A.

common

architecture

with the following

* The 28-pin devices have three 1/0 ports, while the 40/44-pin devices have five.

+ The 28-pin devices have fourteen interrupts, while the 40/44-pin devices have fifteen.

+ The 28-pin devices have five A/D input channels, while the 40/44-pin devices have

eight.

* The Parallel Slave Port is implemented only on the 40/44-pin devices.

Service By KRRC (Central Library)
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Memory Organization

There are three memory blocks in each of the PIC16F87XA devices. The
program memory and data memory have separate buses so that concurrent
access can occur and is detailed in this section. The EEPROM data memory block is
detailed in Section 3.0 “Data EEPROM and Flash Program Memory”. Additional
information on device memory may be found in the PIC micro Mid-Range MCU
Family Reference Manual (DS33023).

Program Memory Organization

The PIC16F87XA devices have a 13-bit program counter capable of addressing
an 8K word x 14 bit program memory space. The PIC16F876A/877A devices
have 8K words x 14 bits of Flash program memory, while PIC16F873A/874A
devices have 4K words x 14 bits. Accessing a location above the physically
implemented address will cause a wraparound.

The Reset vector is at 0000h and the interrupt vector is at 0004h.

23
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LIQUID CRYSTAL DISPLAY (LCD)

Description:

This is the example for the Parallel Port. This example doesn't use the Bi-
directional feature found on newer ports, thus it should work with most, if not all Parallel
Ports. It however doesn't show the use of the Status Port as an input for a 16 Character
x 2 Line LCD Module to the Parallel Port. These LCD Modules are very common these
days, and are quite simple to work with, as all the logic required running them is on
board.

Pros:

e Very compact and light

e Low power consumption

o No geometric distortion

« Little or no flicker depending on backlight technology

o Not affected by screen burn-in

« No high voltage or other hazards present during repair/service
o Can be made in almost any size or shape

e No theoretical resolution limit

LCD Background:

Frequently, an 8051 program must interact with the outside world using input
and output devices that communicate directly with a human being. One of the most
common devices attached to an 8051 is an LCD display. Some of the most common
LCDs connected to the 8051 are 16x2 and 20x4 displays. This means 16 characters per
line by 2 lines and 20 characters per line by 4 lines, respectively.

Fortunately, a very popular standard exists which allows us to communicate with
the vast majority of LCDs regardless of their manufacturer. The standard is referred to
as HD44780U, which refers to the controller chip which receives data from an external

source (in this case, the 8051) and communicates directly with the LCD.

24
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FIG 4.10: LCD

44780 LCD BACKGROUND

The 44780 standard requires 3 control lines as well as either 4 or 8 1/0 lines for
the data bus. The user may select whether the LCD is to operate with a 4-bit data bus or
an 8-bit data bus. If a 4-bit data bus is used the LCD will require a total of 7 data lines (3
control lines plus the 4 lines for the data bus). If an 8-bit data bus is used the LCD will

require a total of 11 data lines (3 control lines plus the 8 lines for the data bus).
LCD

Fiis
—*[07
1 *0E
———*[05
_| ————————*[04
*Enablz
® Register Select
POT

The three control lines are referred to as EN, RS, and RW.

25
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The EN line is called "Enable." This control line is used to tell the LCD that you are
sending it data. To send data to the LCD, your program should make sure this line is low
(0) and then set the other two control lines and/or put data on the data bus. When the
other lines are completely ready, bring EN high (1) and wait for the minimum amount of
time required by the LCD datasheet (this varies from LCD to LCD), and end by bringing it
low (0) again.

The RS line is the "Register Select" line. When RS is low (0), the data is to be
treated as a command or special instruction (such as clear screen, position cursor, etc.).
When RS is high (1), the data being sent is text data which should be displayed on the
screen. For example, to display the letter "T" on the screen you would set RS high.

The RW line is the "Read/Write" control line. When RW is low (0), the information
on the data bus is being written to the LCD. When RW is high (1), the program is
effectively querying (or reading) the LCD. Only one instruction ("Get LCD status") is a
read command. All others are write commands—-so RW will almost always be low
.Finally, the data bus consists of 4 or 8 lines (depending on the mode of operation
selected by the user). In the case of an 8-bit data bus, the lines are referred to as DBO,
DB1, DB2, DB3, DB4, DB5, DB6, and DB7.

26
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SOLAR PANEL

A solar panel (photovoltaic module or photovoltaic panel) is a packaged
interconnected assembly of solar cells, also known as photovoltaic cells. The solar
panel can be used as a component of a larger photovoltaic system to generate and

supply electricity in commercial and residential applications.

Because a single solar panel can only produce a limited amount of power, many
installations contain several panels. A photovoltaic system typically includes an array of

solar panels, an inverter, may contain a battery and interconnection wiring

27
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Solar Panel ™"
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How Solar Panels Work

Photovoltaic (PV) cells are formed from a wafer of semi-conductor material and
although there are now several types in production using different materials, the most

common semi-conductor used is silicon.

Pure crystalline silicon is a poor electrical conductor but treat it with tiny quantities of
an impurity, either phosphorous or arsenic (a process called “doping”) and enough
electrons of these materials are freed to enable a current to pass through. Electrons are
negatively charged so this type of silicon is called N-Type.

Dope silicon with gallium or boron and “holes” are created in the crystalline lattice
where a silicon electron has nothing to bond with. These holes can conduct electrical
current and the lack of an electron creates a positive charge so this type of silicon is

28

Service By KRRC (Central Library)



IR@AIKTC aiktcdspace.org

therefore called P-Type. Both types of silicon are modest electrical conductors, hence

the name semiconductors.

Put a layer of each kind together in a wafer, such as in a PV cell, and the free electrons
in the N side migrate towards the free holes on the P side. This causes a disruption to
the electrical neutrality where the holes and electrons mix at the junction of the two
layers. Eventually a barrier is formed preventing the electrons from crossing to the P
side and an electrical field is formed, separating both sides. This electrical field acts as

a diode, allowing electrons to pass from the P side to the N side, but not vice versa.

Expose the cell to light, and the energy from each photon (light particle) hitting the
silicon, will liberate an electron and a corresponding hole. If this happens within range
of the electric field's influence, the electrons will be sent to the N side and the holes to
the P one, resulting in yet further disruption of electrical neutrality. Apply an external
pathway connecting both sides of the silicon wafer and electrons will flow back to their

original P side to unite with the holes sent there by the electric field.

This flow of electrons is a current; the electrical field in the cell causes a voltage and the
product of these two is power.

Several factors affect the efficiency of a solar cell. Some cells, mainly ones made from
a single material, are only efficient in certain light wavelengths. Single material cells can
at the very most expect to convert about 25% of the light hitting it to electrical power.

29
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TEMPERATURE SENSOR(LM35)

Features

» n Calibrated directly in ° Celsius (Centigrade)
Linear + 10.0 mV/°C scale factor
0.5°C accuracy guarantee able (at +25°C)
Rated for full -55° to +150°C range
Suitable for remote applications
Low cost due to wafer-level trimming
Operates from 4 to 30 volts
Less than 60 pA current drain

> 5 S5 35 3 OS5 35 3

Low self-heating, 0.08°C in still air
Nonlinearity only +1/4°C typical

YV V. .V V V V V V V V
)

n Low impedance output, 0.1 for 1 mA load

The LM35 series are precision integrated-circuit temperature sensors, whose
output voltage is linearly proportional to the Celsius (Centigrade) temperature. The
LM35 thus has an advantage over linear temperature sensors calibrated in
Kelvin, as the user is not required to subtract a large constant voltage from its

output to obtain convenient Centigrade scaling. The LM35 does not require any
external calibration or trimming to provide typical accuracies of +1/4°C at room

temperature and +3/4°C over a full -55 to +150°C temperature range. Low cost
is assured by trimming and calibration at the wafer level. The LM35's low output
impedance, linear output, and precise inherent calibration make interfacing to readout or
control circuitry especially easy. It can be used with single power supplies, or
with plus and minus supplies. As it draws only 60 pA from its supply, it has very low
self-heating, less than 0.1°C in still air. The LM35 is rated to operate over a -55° to
+150°C temperature range, while the LM35C is rated for a -40° to +110°C range
(-10" with improved accuracy). The LM35 series is available packaged in hermetic
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TO-46 transistor packages, while the LM35C, LM35CA, and LM35D are also

available in the plastic TO-92 transistor package. The LM35D is also avail- able in an

8-lead surface mount small outline package and a plastic TO-220 package.

Fig 4.10: Basic Centigrade Temperature Sensor (+2°C to +150°C)

Applications:

The LM35 can be applied easily in the same way as other integrated circuit
temperature sensors. It can be glued or cemented to a surface and its
temperature will be within about 0.01°C of the surface temperature.

This presumes that the ambient air temperature is almost the same as the

surface temperature; if the air temperature were much higher or lower

than the surface temperature, the actual temperature of the LM35 die

would be at an intermediate temperature between the surface

temperature and the air temperature. This is especially true for the TO-92

plastic package, where the copper leads are the principal thermal path to

carry heat into the device, so its temperature might be closer to the air

temperature than to the surface temperature.

To minimize this problem, be sure that the wiring to the LM35, as it

leaves the device, is held at the same temperature as the surface of

interest. The easiest way to do this is to cover up these wires with a

bead of epoxy which will insure that the leads and wires are all at the

same temperature as the surface, and that the LM35 die’s temperature will

not be affected by the air temperature.
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LDR

A photoresistor or light dependent resistor (LDR) is a resistor whose resistance
decreases with increasing incident light intensity. It can also be referred to as a
photoconductor.

A photoresistor is made of a high resistance semiconductor. If light falling on the
device is of high enough frequency, photons absorbed by the semiconductor give bound
electrons enough energy to jump into the conduction band. The resulting free electron
(and its hole partner) conduct electricity, thereby lowering resistance.

A photoelectric device can be either intrinsic or extrinsic. An intrinsic
semiconductor has its own charge carriers and is not an efficient semiconductor, e.g.
silicon. In intrinsic devices the only available electrons are in the valence band, and

hence the photon must have enough energy to excite the electron across the entire

32

Service By KRRC (Central Library)



IR@AIKTC aiktcdspace.org

band gap. Extrinsic devices have impurities, also called dopants, added whose ground
state energy is closer to the conduction band; since the electrons do not have as far to
jump, lower energy photons (i.e., longer wavelengths and lower frequencies) are
sufficient to trigger the device. If a sample of silicon has some of its atoms replaced by
phosphorus atoms (impurities), there will be extra electrons available for conduction.

This is an example of an extrinsic semiconductor.
APPLICATIONS

Photoresistor come in many different types. Inexpensive cadmium sulfide cells
can be found in many consumer items such as camera light meters, street lights, clock

radios, alarms, and outdoor clocks.

They are also used in some dynamic compressors together with a small
incandescent lamp or light emitting diode to control gain reduction.

Lead sulfide (PbS) and indium antimonide (InSb) LDRs (light dependent resistor)
are used for the mid infrared spectral region. Ge:Cu photoconductors are among the
best far-infrared detectors available, and are used for infrared astronomy and infrared

spectroscopy.
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1N4007

Diodes are used to convert AC into DC these are used as half wave rectifier or full
wave rectifier. Three points must he kept in mind while using any type of diode.

1. Maximum forward current capacity
2. Maximum reverse voltage capacity
3. Maximum forward voltage capacity

Fig: TN4007 diodes

The number and voltage capacity of some of the important diodes available in the
market are as follows:

« Diodes of number IN4001, IN4002, IN4003, IN4004, IN4005, IN4006 and IN4007
have maximum reverse bias voltage capacity of 50V and maximum forward current
capacity of 1 Amp.

« Diode of same capacities can be used in place of one another. Besides this diode
of more capacity can be used in place of diode of low capacity but diode of low
capacity cannot be used in place of diode of high capacity. For example, in place of
IN4002; IN4001 or IN4007 can be used but IN4001 or IN4002 cannot be used in place of
IN4007.The diode BY125made by company BEL is equivalent of diode from IN4001 to
IN4003. BY 126 is equivalent to diodes IN4004 to 4006 and BY 127 is equivalent to
diode IN4007.
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Fig:PN Junction diode

PN JUNCTION OPERATION

Now that you are familiar with P- and N-type materials, how these materials are
joined together to form a diode, and the function of the diode, let us continue our
discussion with the operation of the PN junction. But before we can understand how the
PN junction works, we must first consider current flow in the materials that make up the
junction and what happens initially within the junction when these two materials are
joined together.

Current Flow in the N-Type Material

Conduction in the N-type semiconductor, or crystal, is similar to conduction in a copper
wire. That is, with voltage applied across the material, electrons will move through the
crystal just as current would flow in a copper wire. This is shown in figure 1-15. The
positive potential of the battery will attract the free electrons in the crystal. These
electrons will leave the crystal and flow into the positive terminal of the battery. As an
electron leaves the crystal, an electron from the negative terminal of the battery will
enter the crystal, thus completing the current path. Therefore, the majority current carriers in the
N-type material (electrons) are repelled by the negative side of the battery and move

through the crystal toward the positive side of the battery.
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Current Flow in the P-Type Material

Current flow through the P-type material is illustrated. Conduction in the P material
is by positive holes, instead of negative electrons. A hole moves from the positive
terminal of the P material to the negative terminal. Electrons from the external circuit
enter the negative terminal of the material and fill holes in the vicinity of this terminal.
At the positive terminal, electrons are removed from the covalent bonds, thus creating
new holes. This process continues as the steady stream of holes (hole current) moves

toward the negative terminal
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LED

A light-emitting diode (LED) is a semiconductor light source. LEDs are used as indicator
lamps in many devices, and are increasingly used for lighting. When a light-emitting
diode is forward biased (switched on), electrons are able to recombine with holes within
the device, releasing energy in the form of photons. This effect is called
electroluminescence and the color of the light (corresponding to the energy of the
photon) is determined by the energy gap of the semiconductor. An LED is often small in
area (less than 1 mm®), and integrated optical components may be used to shape its
radiation pattern. LEDs present many advantages over incandescent light sources
including lower energy consumption, longer lifetime, improved robustness, smaller size,

faster switching, and greater durability and reliability.

Types of LED’S

Light-emitting diodes are used in applications as diverse as replacements for aviation
lighting, automotive lighting as well as in traffic signals. The compact size, the
possibility of narrow bandwidth, switching speed, and extreme reliability of LEDs has
allowed new text and video displays and sensors to be developed, while their high
switching rates are also useful in advanced communications technology.

Electronic Symbol:
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RESISTORS

A resistor is a two-terminal electronic component designed to oppose an electric
current by producing a voltage drop between its terminals in proportion to the current,
that is, in accordance with Ohm's law:
V=IR

Resistors are used as part of electrical networks and electronic circuits. They are
extremely commonplace in most electronic equipment. Practical resistors can be made
of various compounds and films, as well as resistance wire (wire made of a high-
resistivity alloy, such as nickel/chrome).

The primary characteristics of resistors are their resistance and the power
they can dissipate. Other characteristics include temperature coefficient, noise, and
inductance. Less well-known is critical resistance, the value below which power
dissipation limits the maximum permitted current flow, and above which the limit is
applied voltage. Critical resistance depends upon the materials constituting the resistor
as well as its physical dimensions; it's determined by design.

Resistors can be integrated into hybrid and printed circuits, as well as
integrated circuits. Size, and position of leads (or terminals) are relevant to equipment
designers; resistors must be physically large enough not to overheat when dissipating

their power.
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A resistor is a two-terminal passive electronic component which implements
electrical resistance as a circuit element. When a voltage V is applied across the
terminals of a resistor, a current | will flow through the resistor in direct proportion to
that voltage. The reciprocal of the constant of proportionality is known as the
resistance R, since, with a given voltage V, a larger value of R further "resists" the flow
of current | as given by Ohm's law:

Resistors are common elements of electrical networks and electronic circuits
and are ubiquitous in most electronic equipment. Practical resistors can be made of
various compounds and films, as well as resistance wire (wire made of a high-resistivity
alloy, such as nickel-chrome). Resistors are also implemented within integrated circuits,
particularly analog devices, and can also be integrated into hybrid and printed circuits.

The electrical functionality of a resistor is specified by its resistance: common
commercial resistors are manufactured over a range of more than 9 orders of
magnitude. When specifying that resistance in an electronic design, the required
precision of the resistance may require attention to the manufacturing tolerance of the
chosen resistor, according to its specific application. The temperature coefficient of the
resistance may also be of concern in some precision applications. Practical resistors

are also specified as having a maximum power rating which must exceed the
39

Service By KRRC (Central Library)



IR@AIKTC aiktcdspace.org

anticipated power dissipation of that resistor in a particular circuit: this is mainly of
concern in power electronics applications. Resistors with higher power ratings are
physically larger and may require heat sinking. In a high voltage circuit, attention must
sometimes be paid to the rated maximum working voltage of the resistor.

The series inductance of a practical resistor causes its behavior to depart from
ohms law; this specification can be important in some high-frequency applications for
smaller values of resistance. In a low-noise amplifier or pre-amp the noise
characteristics of a resistor may be an issue. The unwanted inductance, excess noise,
and temperature coefficient are mainly dependent on the technology used in
manufacturing the resistor. They are not normally specified individually for a particular
family of resistors manufactured using a particular technology. A family of discrete
resistors is also characterized according to its form factor, that is, the size of the device
and position of its leads (or terminals) which is relevant in the practical manufacturing

of circuits using them.

Units

The ohm (symbol: Q) is the Sl unit of electrical resistance, named after Georg
Simon Ohm. An ohm is equivalent to a volt per ampere. Since resistors are specified
and manufactured over a very large range of values, the derived units of milliohm (1 mQ
=107° Q), kilohm (1 kQ = 10° Q), and megohm (1 MQ = 10° Q) are also in common usage.

The reciprocal of resistance R is called conductance G = 1/R and is measured in
Siemens (S| unit), sometimes referred to as a mho. Thus a Siemens is the reciprocal of
an ohm: S=Q ~'. Although the concept of conductance is often used in circuit analysis,
practical resistors are always specified in terms of their resistance (ohms) rather than

conductance.

Theory of operation
Ohm's law

The behavior of an ideal resistor is dictated by the relationship specified in Ohm's law:
V=IR
Ohm's law states that the voltage (V) across a resistor is proportional to the current (1)
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passing through it, where the constant of proportionality is the resistance (R).

Equivalently, Ohm's law can be stated:

14
I==
R

This formulation of Ohm's law states that, when a voltage (V) is present across a
resistance (R), a current (I) will flow through the resistance. This is directly used in
practical computations. For example, if a 300 ohm resistor is attached across the
terminals of a 12 volt battery, then a current of 12 / 300 = 0.04 amperes (or 40

milliamperes) will flow through that resistor.

Series and parallel resistors

In a series configuration, the current through all of the resistors is the same, but
the voltage across each resistor will be in proportion to its resistance. The potential
difference (voltage) seen across the network is the sum of those voltages, thus the

total resistance can be found as the sum of those resistances:

Req = Ry + Ry +--- + Ry
As a special case, the resistance of N resistors connected in series, each of the same
resistance R, is given by NR.
Resistors in a parallel configuration are each subject to the same potential difference
(voltage), however the currents through them add. The conductances of the resistors
then add to determine the conductance of the network. Thus the equivalent resistance

(Req) of the network can be computed:
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1]

The parallel equivalent resistance can be represented in equations by two vertical lines
"II" (as in geometry) as a simplified notation. For the case of two resistors in parallel,
this can be calculated using:

R R,
— RJR, = 1242
Req 1” ? Ry + R,

As a special case, the resistance of N resistors connected in parallel, each of the same
resistance R, is given by R/N.

A resistor network that is a combination of parallel and series connections can be
broken up into smaller parts that are either one or the other. For instance,

©

SRy

SR, $R

Ry Ry

=(R||R Ry= ———
Req = (Ri||R2) + Rs R

+ Ry
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However, some complex networks of resistors cannot be resolved in this manner,
requiring more sophisticated circuit analysis. For instance, consider a cube, each edge
of which has been replaced by a resistor. What then is the resistance that would be
measured between two opposite vertices? In the case of 12 equivalent resistors, it can
be shown that the corner-to-corner resistance is °/s of the individual resistance. More
generally, the Y-A transform, or matrix methods can be used to solve such a problem.
One practical application of these relationships is that a non-standard value of
resistance can generally be synthesized by connecting a number of standard values in
series and/or parallel. This can also be used to obtain a resistance with a higher power
rating than that of the individual resistors used. In the special case of N identical
resistors all connected in series or all connected in parallel, the power rating of the
individual resistors is thereby multiplied by N.

Power dissipation

The power P dissipated by a resistor (or the equivalent resistance of a resistor network)
V2

, P=IFR=1IV=—

is calculated as: R

The first form is a restatement of Joule's first law. Using Ohm's law, the two other
forms can be derived.

The total amount of heat energy released over a period of time can be determined from
the integral of the power over that period of time:

W= /f * o(b)i(t)dt.

i
Practical resistors are rated according to their maximum power dissipation. The
vast majority of resistors used in electronic circuits absorb much less than a watt of
electrical power and require no attention to their power rating. Such resistors in their
discrete form, including most of the packages detailed below, are typically rated as
1/10, 1/8, or 1/4 watt.
Resistors required to dissipate substantial amounts of power, particularly used in power
supplies, power conversion circuits, and power amplifiers, are generally referred to as

power resistors; this designation is loosely applied to resistors with power ratings of 1
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watt or greater. Power resistors are physically larger and tend not to use the preferred
values, color codes, and external packages described below.

If the average power dissipated by a resistor is more than its power rating,
damage to the resistor may occur, permanently altering its resistance; this is distinct
from the reversible change in resistance due to its temperature coefficient when it
warms. Excessive power dissipation may raise the temperature of the resistor to a point
where it can burn the circuit board or adjacent components, or even cause a fire. There
are flameproof resistors that fail (open circuit) before they overheat dangerously.

Note that the nominal power rating of a resistor is not the same as the power
that it can safely dissipate in practical use. Air circulation and proximity to a circuit
board, ambient temperature, and other factors can reduce acceptable dissipation
significantly. Rated power dissipation may be given for an ambient temperature of 25 °C
in free air. Inside an equipment case at 60 °C, rated dissipation will be significantly less;
a resistor dissipating a bit less than the maximum figure given by the manufacturer may

still be outside the safe operating area and may prematurely fail.
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CAPACITORS

A capacitor or condenser is a passive electronic component consisting of a
pair of conductors separated by a dielectric. When a voltage potential difference exists
between the conductors, an electric field is present in the dielectric. This field stores
energy and produces a mechanical force between the plates. The effect is greatest
between wide, flat, parallel, narrowly separated conductors.

An ideal capacitor is characterized by a single constant value, capacitance,
which is measured in farads. This is the ratio of the electric charge on each conductor
to the potential difference between them. In practice, the dielectric between the plates
passes a small amount of leakage current. The conductors and leads introduce an
equivalent series resistance and the dielectric has an electric field strength limit
resulting in a breakdown voltage.

The properties of capacitors in a circuit may determine the resonant frequency
and quality factor of a resonant circuit, power dissipation and operating frequency in a
digital logic circuit, energy capacity in a high-power system, and many other important

aspects.
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A capacitor (formerly known as condenser) is a device for storing electric charge.
The forms of practical capacitors vary widely, but all contain at least two conductors
separated by a non-conductor. Capacitors used as parts of electrical systems, for
example, consist of metal foils separated by a layer of insulating film.

Capacitors are widely used in electronic circuits for blocking direct current while
allowing alternating current to pass, in filter networks, for smoothing the output of
power supplies, in the resonant circuits that tune radios to particular frequencies and
for many other purposes.

A capacitor is a passive electronic component consisting of a pair of conductors
separated by a dielectric (insulator). When there is a potential difference (voltage)
across the conductors, a static electric field develops in the dielectric that stores energy
and produces a mechanical force between the conductors. An ideal capacitor is
characterized by a single constant value, capacitance, measured in farads. This is the
ratio of the electric charge on each conductor to the potential difference between them.

The capacitance is greatest when there is a narrow separation between large
areas of conductor, hence capacitor conductors are often called "plates”, referring to an
early means of construction. In practice the dielectric between the plates passes a
small amount of leakage current and also has an electric field strength limit, resulting in
a breakdown voltage, while the conductors and leads introduce an undesired

inductance and resistance.
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SOFTWARE REQUIREMENTS
What is MPLAB IDE?

MPLAB IDE is a software program that runs on a PC to develop applications

for Microchip microcontrollers. It is called an Integrated Development
Environment, or IDE, because it provides a single integrated environment to
develop code for embedded microcontrollers.

Description of an Embedded System

An embedded system is typically a design making use of the power of a
small microcontroller, like the Microchip PIC micro MCU or dsPIC Digital
Signal Controller(DSCs). These microcontrollers combine a microprocessor
unit (like the CPU in a desk- top PC) with some additional circuits called
peripherals, plus some additional circuits on the same chip to make a small
control module requiring few other external devices. This single device can
then be embedded into other electronic and mechanical devices for low-
cost digital control.

Components of a Microcontroller

The PIC micro MCU has program memory for the firmware, or coded
instructions, to run a program. It also has file register memory for storage
of variables that the program will need for computation or temporary
storage. It also has a number of peripheral device circuits on the same chip.
Some peripheral devices are called 1/0 ports. 1/0 ports are pins on the
microcontroller that can be driven high or low to send signals, blink lights,
drive speakers fi just about anything that can be sent through a wire. Often
these pins are bidirectional and can also be configured as inputs allowing
the program to respond to an external switch, sensor or to communicate

with some external device.

47

Service By KRRC (Central Library)



IR@AIKTC aiktcdspace.org

Data Bus<8> PORTA
RAO/ANO
9 Table Pointer<21> vDa‘ra Latch RA2/AN2/VREF-
8 8 RA3/AN3/VReF+
_ BataHAM RA4/TOCKI
21 Inc/Dec Logic RA5/AN4/LVDIN
Address|Latch RAG
21 PCLATU PCLATH 12 PORTB
RBO/INTO
Address<12>
—— PCU PCH PCL RBT/INT]
Proaram Courjter a 12 4 RB2/INT2
BSR Banko, f—— RB3/INT3
Address Latch Fsro AN !
&l FSR1
RB5/KBI1/PGM
Memory 1 RB6/KBI2/PGC
Data Latch RB7/KBI3/PGD
Inc/Nec
Decode Logic PORTC
Table Latch RCO/T10S0/T13CKI
* 4 B
16 RC2/CCP1
OM Latch RC3/SCK/SCL
J; RC4/SDI/SDA
IR \4
RC6/TX1/CK1
RC7/RX1/DT1

In order to design such a system, it must be decided which peripherals are
needed for an application. Analog-to-Digital Converters (ADCs) allow
microcontrollers to connect to sensors and receive changing voltage levels.
Serial communication peripherals allow you to stream communications over
a few wires to another microcontroller, to a local network or to the internet.
Peripherals on the PIC micro MCU called timers accurately measure signal
events and generate and capture communications signals, pro- duce precise
waveforms, even automatically reset the microcontroller if it gets hung or lost
due to a power glitch or hardware malfunction. Other peripherals detect if the
external power is dipping below dangerous levels so the microcontroller can
store critical information and safely shut down before power is completely
lost.
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The peripherals and the amount of memory an application needs to run a
program largely determines which PIC micro MCU to use. Other factors might
include the power consumed by the microcontroller and its form factor, i.e.,
the size and characteristics of the physical package that must reside on the

target design.

PICmicro MCU DEVICE PACKAGE

—_—

Fig 5.3.1:Implementing an Embedded System Design with MPLAB IDE

A development system for embedded controllers is a system of programs
running on a desktop PC to help write, edit, debug and program code fi the
intelligence of embedded systems applications A into a microcontroller.
MPLAB IDE runs on a PC and contains all the components needed to design
and deploy embedded systems applications. The typical tasks for

developing an embedded controller application are:

1. Create the high level design. From the features and performance desired,
decide which PIC micro MCU or dsPIC DSC device is best suited to the
application, then design the associated hardware circui'try. After
determining which peripherals and pins control the hardware, write the
firmware fi the software that will control the hardware aspects of the
embedded application. A language tool such as an assembler, which is
directly translatable into machine code, or a compiler that allows a more

natural language for creating programs, should be used to write and edit
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code. Assemblers and compilers help make the code understandable,

allowing function labels to identify code routines with variables that have

names associated with their use, and with constructs that help organize

the code in a maintainable structure.
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Fig 5.3.2:PICmicro MCU DATA SHEET fi INSTRUCTIONS

2. Compile, assemble and link the software using the assembler and/or
compiler and linker to convert your code into ones and zeroes i machine code
for the PIC micro MCUs. This machine code will eventually become the

firmware (the code programmed into the microcontroller).

3.Test your code. Usually a complex program does not work exactly the way
imagined, and bugs need to be removed from the design to get proper results.
The debugger allows you to see the ones and zeroes execute, related to the
source code you wrote, with the symbols and function names from your
program. Debugging allows you to experiment with your code to see the value
of variable sat various points in the program, and to do what if check,

changing variable values and stepping through routines.
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4. Burn the code into a microcontroller and verify that it executes correctly in

the finished application. Of course, each of these steps can be quite complex.
The important thing is to concentrate on the details of your own design, while
relying upon MPLAB IDE and its components to get through each step without

continuously encountering new learning curves.

THE DEVELOPMENT CYCLE

The process for writing an application is often described as a
development cycle, since it is rare that all the steps from design to
implementation can be done flawlessly the first time. More often code is
written, tested and then modified in order to produce an application that
performs correctly. The Integrated Development Environment allows the
embedded systems design engineer to progress through this cycle without
the distraction of switching among an array of tools. By using MPLAB IDE, all
the functions are integrated, allowing the engineer to concentrate on
completing the application without the interruption of separate tools and

different modes of operation.

THE DESIGN CYCLE

/"\

Compile/Assemble/ Download Code to
Link Code Debugger

Edit/Create/Design Analyze/Debug
Saurca Cada Code

~——
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MPLAB IDE is a wrapper that coordinates all the tools from a single
graphical user interface, usually automatically. For instance, once code is
written, it can be converted to executable instructions and downloaded into a
microcontroller to see how it works. In this process multiple tools are needed:
an editor to write the code, a project manager to organize files and settings, a
compiler or assembler to convert the source code to machine code and some
sort of hardware or software that either connects to a target microcontroller

or simulates the operation of a microcontroller.

PROJECT MANAGER

The project manager organizes the files to be edited and other
associated files so they can be sent to the language tools for assembly or
compilation, and ultimately to a linker. The linker has the task of placing the
object code fragments from the assembler, compiler and libraries into the
proper memory areas of the embedded controller, and ensure that the
modules function with each other. This entire operation from assembly and
compilation through the link process is called a project build.

Fig.5.5: MPLAB IDE PROJECT MANAGER

Source MPLAB IDE
Files Project
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Build
File

Libraries
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From the MPLAB IDE project manager, properties of the language
tools can be invoked differently for each file, if desired, and a build process
integrates all of the language tools operations.

The source files are text files that are written conforming to the rules
of the assembler or compiler. The assembler and compiler convert them
into intermediate modules of machine code and placeholders for references
to functions and data storage. The linker resolves these placeholders and
combines all the modules into a file of executable machine code. The linker
also produces a debug file which allows MPLAB IDE to relate the executing
machine codes back to the source files. A text editor is used to write the
code. It is not a normal text editor, but an editor specifically designed for
writing code for Microchip MCUs. It recognizes the constructs in the text
and uses color coding to identify various elements, such as instruction
mnemonics, C language constructs and comments. The editor supports
operations commonly used in writing source code, such as finding matching
braces in C, commenting and un-commenting out blocks of code, finding
text in multiple files and adding special bookmarks. After the code is written,
the editor works with the other tools to display code execution in the
debugger. Breakpoints can be set in the editor, and the values of variables
can be inspected by hovering the mouse pointer over the variable name.
Names of variables can be dragged from source text windows and then

dropped into a Watch window.
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DEVICE PROGRAMMING

After the application has been debugged and is running in the
development environment, it needs to be tested on its own. A device can
be programmed with the in-circuit debugger or a device programmer.
MPLAB IDE can be set to the programmer function, and the part can be
burned. The target application can now be observed in its nearly final state.
Engineering prototype programmers allow quick prototypes to be made
and evaluated. Some applications can be programmed after the device is
soldered on the target PC board. Using In-Circuit Serial Programmingd
(ICSP6) programming capability, the firmware can be programmed into
the application at the time of manufacture, allowing updated revisions to
be programmed into an embedded application later in its life cycle. Devices
that support in-circuit debugging can even be plugged back into the MPLAB
ICD 2 after manufacturing for quality tests and development of next

generation firmware.

COMPONENTS OF MPLAB IDE
The MPLAB IDE has both built-in components and plug-in modules to

configure the system for a variety of software and hardware tools.

MPLAB IDE Built-in Components

The built-in components consist of:

Project Manager:
The project manager provides integration and communication

between the IDE and the language tools.
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1 Editor
The editor is a full-featured programmer's text editor that also serves

as a window into the debugger.

T Assembler/Linker and Language Tools

The assembler can be used stand-alone to assemble a single file, or
can be used with the linker to build a project from separate source files,
libraries and recompiled objects. The linker is responsible for positioning the

compiled code into memory areas of the target microcontroller.

T Debugger

The Microchip debugger allows breakpoints, single stepping, watch
windows and all the features of a modern debugger for the MPLAB IDE. It
works in conjunction with the editor to reference information from the target

being debugged back to the source code.

T Execution Engines

There are software simulators in MPLAB IDE for all PIC micro MCU
and dsPIC DSC devices. These simulators use the PC to simulate the
instructions and some peripheral functions of the PIC micro MCU and dsPIC
DSC devices. Optional in-circuit emulators and in-circuit debuggers are also
available to test code as it runs in the applications hardware.
After installation or select Start>Programs>Microchip>MPLAB IDE
vx.xx>MPLAB IDE. A screen will display the MPLAB IDE logo followed by the
MPLAB IDE desktop.
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MPLAB IDE DESKTOP

g .
File Edit Yiew Project Debugger Programmer Tools Configure Window Help

J D= |27 J Checksum: 0x82d8
“lUntitled Works... (=)@

I_| Build | Version Eontrol| Find in Files l

| PIC18F452 | W0 llmovzdee |

SELECTING THE DEVICE
To show menu selections in this document, the menu item from the
top row in MPLAB IDE will be shown after the menu name like this

MenuName>Menultem. To choose the Select Device entry in the Configure

menu, it would be written as Configure>Select Device. Choose
Configure>Select Device. In the Device dialog, select the PIC18F8722 from
the list if itis not already selected.
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Device: Device Family:
[Pic1aFsT22 ] 1800 ™
Microchip Programmer Tool Support
@ PICSTART Plus @ MPLABICD 2
@ PROMATE Il @ PICkit1
& MPLAB PM3
Microchip Language Tool Support
@ ASSEMBLER @ COMPILER
w3.90 w2 40
Microchip Dehugger Tool Support
& MPLAB SIM @ MPLABICD 2
MPLAB ICE 2000 MPLAB ICE 4000
@PCM18KE0 @ PMF12WS0
Ok ] [ Cancel ] [ Help

The lights indicate which MPLAB IDE components support this device.

1 A green light indicates full support.

T A yellow light indicates preliminary support for an upcoming part by the
particular MPLAB IDE tool component. Components with a yellow light
instead of a green light are often intended for early adopters of new parts
who need quick support and understand that some operations or functions
may not be available.

T A red light indicates no support for this device. Support may be
forthcoming or inappropriate for the tool, e.g., dsPIC DSC devices cannot be
supported on MPLAB ICE 2000.

CREATING THE PROJECT

The next step is to create a project using the Project Wizard. A project is the

way the files are organized to be compiled and assembled. We will use a
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single assembly file for this project and a linker script. Choose

Project>Project Wizard. From the Welcome dialog, click on Next> to

advance. The next dialog (Step One) allows you to select the device, which

we have already done. Make sure that it says PIC18F8722.

If it does not, select the PIC18F8722 from the drop down menu. Click Next>.
PROJECT WIZARD i SELECT DEVICE

Project Wizard

Step One:
Select a device /
0

|PiC1aFa72d v

< Back ” Mewt » ][ Cancel ] [ Help

SETTING UP LANGUAGE TOOLS

Step Two of the Project Wizard sets up the language tools that are used
with this project. Select Microchip MPASM Toolsuite in the Active Toolsuite
list box. Then MPASM and MPLINK should be visible in the Toolsuite
Contents box. Click on each one to see its location. If MPLAB IDE was

installed into the default directory, the MPASM assembler executable will be:

C:\Program Files\Microchip\MPASM Suite\mpasmwin.exe
the MPLINK linker executable will be:

C:\Program Files\Microchip\MPASM Suite\mplink.exe
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and the MPLIB librarian executable will be:

C:\Program Files\Microchip\MPASM Suite\mplib.exe
If these do not show up correctly, use the browse button to
set them to the proper files in the MPLAB IDE subfolders.
BUILDING THE PROJECT
From the Project menu, we can assemble and link the current files. They
donit have any of our code in them yet, but this ensures that the project is
set up correctly.
To build the project, select either:
1 Project>Build All

1 Right click on the project name in the project window and select Build All

1 Click the Build All icon on the Project toolbar. Hover the mouse over icons
to see pop-up text of what they represent.

The Output window shows the result of the build process. There should be
no errors on any step. The warnings listed in Figure will not interfere with
the operation of the tutorial pro- gram. They are merely identifying a
directive that has been deprecated, i.e., is being discontinued in favor of

another. To turn off the display of warnings, do the following:

T Select Project>Build Options>Project and click on the MPASM Assembler
tab.

1 Select i0utputi from the iCategoriesi drop-down list.
1 Select iErrors onlyi from the iDiagnostic leveli drop-down list.
1 Click OK.
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EMBEDDED C

Use of embedded processors in passenger cars, mobile phones, medical
equipment, aerospace systems and defense systems is widespread, and
even everyday domestic appliances such as dish washers, televisions,
washing machines and video recorders now include at least one such
device.

Because most embedded projects have severe cost constraints,
they tend to use low-cost processors. These popular chips have very
limited resources available most such devices have around limited amount
of RAM, and the available processor power is around many times less than
that of a desktop processor. As a result, developing embedded software
presents significant new challenges, even for experienced desktop
programmers. |If you have some programming experience - in C, C++ or
Java - then this book and its accompanying CD will help make your move to

the embedded world as quick and painless as possible.
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DESCRIPTION

POWERSUPPLY

The circuit uses standard power supply comprising of a step-down transformer
from 230v to 12v and 4 diodes forming a Bridge Rectifier that delivers pulsating dc
which is then filtered by an electrolytic capacitor of about 470microf to 100microF. The
filtered dc being unregulated IC LM7805 is used to get 5v constant at its pin no 3
irrespective of input dc varying from 9v to 14v. The input dc shall be varying in the event
of input ac at 230volts section varies in the ratio of v1/v2=n1/n2.

The regulated 5volts dc is further filtered by a small electrolytic capacitor of 10
micro f for any noise so generated by the circuit. One LED is connected of this 5v point
in series with a resistor of 330ohms to the ground i.e. negative voltage to indicate Sv
power supply availability. The 5v dc is at 12v point is used for other applications as on

when required.

OPERATION
CONNECTIONS

The output of the power supply which is 5v is connected to 11 and 32 pins of micro
controller and GND is connected to its 12 and 31 pins. Pin 2 of controller is connected to
pin 2 of LDR sensor, Pin 3 of controller is connected to pin 2 of LM35 temperature sensor,
Pin 4 of controller is connected to voltage sensing ckt & Pin 5 of controller is connected to

current sensing ckt.
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WORKING

The Voltage from the solar panel is fed to the MC pin no 4 through a potential divider
comprising of R4 & RS5. Zener diode D6 is used to protect the input to the
microcontroller exceeding 5V. a 100ohm, 5W resistor R6 is used as load in series with
another resistor R7 of 10ohm, 10W. a variable resistor 100K is used for setting/
calibrating the current parameters. The voltage drop across the resistor R7 is
proportional to the load current which is fed to pin 5 of MC in a small portion by the
variable resistor. Light input is sensed by LDR1 in combination with resistor R3 the
common point of which is fed to MC pin 2. A temperature sensor LM35 (U3) delivers the
output in analog voltage proportional to the heat on its surface being connected to pin 3
of MC. Thus, four analog varying voltage parameters are fed to the internal ADC of the
MC out of total availablibiliy of 8 channels. A LCD is used to display all the output
parameters such as light intensity, temperature, voltage and current of solar panel. The
unit can be used either from the power supply comprising of TR1, D1-D4, C1, 7805, C2
R1 & D5 or can be directly fed from 6V source of the solar panel.
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LAYOUT DIAGRAM
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CONCLUSION

In this Project we tried to measure parameters of solar panels

such as Voltage, current, power, temperature and intensity
of light using PIC16F877A microcontroller.

Digital display can be used to display values of these
parameters. PIC microcontroller can be used to measure
analog values of these sensed parameters and analog to
digital to converter which is in built in PIC microcontroller
can be used to measure values of these parameters.

There are many ways to sense voltage. But in this proposed
work we can easily measure voltage of solar panel using
voltage divider. Two capacitors are connect parallel to
voltage measurement resistor to avoid voltage fluctuation
and avoid harmonics to go into ADC of PIC microcontroller
Here we have used differential amplifier to amplify voltage
appearing across shunt resistor, because current value may

be too high and too low in different timings.
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